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Indiana Water Quality Atlas

IWQA

Users Guide
Introduction

The Indiana Waters Quality Atlas (IWQA) has undergone several changes since its inception.  The latest revisions have been made to provide users with more tools and flexibility for generating maps and spatial and statistical analyses of hydrographic and water quality data.  This version includes our new ArcGIS Explorer interface.  With assistance from the ESRI, Inc. and the Purdue University, this application runs smoother, faster, and is easier to navigate.  The tools and data previously provided have been retained and enhanced to offer watershed coordinators and the general public with the same capabilities as before but with a few new features.  These features include customized numbered basemaps from which watershed coordinators can follow step by step instructions for developing the necessary maps and spatial analyses for their watershed management planning activities and final document.  

Along with the instructions provided here, there is the software Help documentation that comes with ArcGIS Explorer and the assistance that can be found on the ESRI, Inc. website at www.esri.com.

Please report any issues or problems with using this application to the IDEM Office of Water Quality, Watershed Assessment and Planning Branch, IWQA Application Manager or the IDEM GIS Coordinator.
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1. Opening the application
As a brief recap on the installation for establishing alternate locations of this application, the process for downloading the ArcGIS Explorer (AGX) and IWQA application starts at www.in.gov/idem/5219.htm.  Click on the link to download the AGX software and follow the directions for installing.  Next, click on the IWQA link to download the application that will customize your AGX package for the development of maps for watersheds and water quality exploration.  Once both are downloaded and the AGX software installed, run the IWQA installation file by double clicking on it.  It will proceed to install and establish a program link in your Programs directory (under Start) entitled Indiana Water Quality Atlas.  Access to the AGX software without the IWQA application will still be available by using the AGX icon on your desktop, however to use the features and tools of the IWQA, open the application through Start( Programs ( Indiana Water Quality Atlas ( Indiana Water Quality Atlas.
2. Orientation on tools, tabs and buttons in the default map.
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         Tabs across the top change tool sets.







         Tools to the left include dropdowns.
       Below right in the corner of the map are 
       the buttons for on-screen pan and zoom 
       functions in gray.  They expand when 

       your cursor hovers over the tool.  There
       is also a full extent button as well.
       This is the Contents Window which can 

       be hidden when not in use.  This is also

       where additional functions are found to

       manipulate the attributes of layers and 

       services.
       More details will be provided as each 
       tool is discussed.

In the top left hand corner of the application is the world button which offers a dropdown for options to open, save, and print new and existing maps and map projects.  These are functions formerly listed under the File menu item in previous versions of Arc Explorer.
In the tabs bar, there is Home, IWQA Tools, Display, and Tools, each of which provide for the customization of your map(s).  Any of the tools can be added to the Quick Assess Toolbar by right clicking on the tool and choosing Add to Quick Assess Toolbar.  The Quick Assess Toolbar is located next to the World button and comes with the save button already provided.  Any tools added to this toolbar will remain until removed by right clicking on one and choosing Remove.  This allows the user to customize Quick Tools for reoccurring processes between projects/maps.
Under Home, there is the Map List, Create (features), Basemap, Add Content, Contents Window, plus 3 other tools for managing, copying, and zooming into your data layers.  The Map List contains optional basemaps specifically to assist with watershed management plan development but can be used for other purposes.  Others can be developed and added to the list by the user and instructions for developing these maps will be provided.  The Basemap offers other base data layers of roads and/or ortho-imagery that may be useful and can be added to the current map Contents Window.  The Content Window is listed to allow for toggling the left side of the application off and on, should additional screen space be needed while working on a map.  And finally, the Add Contents dropdown offers choices of types of data layers that are possible to use in this application.  Traditionally, the shapefile, raster data, and geodatabase files are the most frequently added by the user, however the other options are provided where the locations of these sources are known and available locally or via the Internet.
Under the IWQA Tools, there is the Add Legend tool, a Watershed Navigator tool, a Graph AIMS Data tool (specifically for the water quality data provided by the IDEM Assessment Information Management System - AIMS), and the Identify tool.  The Add Legend tool provides the Legend on the screen with the map for publishing.  It is important to include a Legend with your map for clear communication on the various features represented.  The Watershed Navigator is a popup that allows the user to select an existing watershed name or hydrologic unit code (HUC).  This tool provides a Zoom to Watershed button and an Add Watershed to Map button, together to give the user a faster way to find the watershed and highlight it for best results.  The Identify tool provides the user with additional single point query capabilities.  By clicking on any point on the map with the Identify tool crosshairs, a query will be made to the service for tabular data associated with every layer with data at that location.  The graphing tool is used with the AIMS data to help interpret the data for reporting and decision-making purposes.
In the L-THIA section there is the Watershed Delineator and Long-Term Hydrologic Impact Analysis (L-THIA) tools, provided in the previous version of the IWQA for watershed planning and analyses.  More details will be provided under later in this document.

The last section under IWQA Tools provides the user with the ability to extract the water quality data in AIMS based upon the watershed extent requested.  This can be downloaded and used in other statistical and reporting software.

Under the Display tab, the user can set the desired coordinate system, scale units and decide upon a scale bar or grids to spatially reference the map.  The Distance dropdown will likely be the most used since the default is set to Meters, Kilometers and dropping down to Feet, Miles may make for easier interpretation of the distances by map users.

The last tabs bar item (which appears when a layer in the Contents Window is selected)  is for the Tools that include Popup Content (also available under the Layer Properties), the Export and E-Mail tools, Draw Tools for organizing the map layers, plus the Effects Tools for assisting in spatial analysis and visualization.  Additional tools for customizing the attributes of the features are available under the Home tab Create box, adjacent to the Maps list on the left.
3. Using basemap GIS services 

In the default map, as provided by this Indiana Water Quality Atlas application, there is, in the Contents Window, a Simple Basemap (IWQA/IWQA_SimpBaseMap) which provides the illustration in the map window to the right.  This GIS Service holds many more layers than seen upon opening the application.  Included in this Basemap service are sub-layers and annotation for labels for the following datasets: streams and lakes, cities, counties, roads, and the current and historical watershed delineations.  These are annotated in separate layers to provide for the greatest flexibility in offering labels.  Further instructions will explain how to access these layers for customization of your map(s).
Additional and/or alternative basemaps are offered under the dropdown tool called Basemap.  These are provided through external services via the web as part of the AGX package.  The Basemaps under the Home tab are selected by clicking on one and it will be added to the Contents Window.  These are different from the maps in the Maps List options, i.e., 1-Project Area, 2-Soils, 3-LndUse, 4-ExistingActn, 5-DataSources, 6-CriticalArea, and 7-LndUse test.  
The Map List offers the templates for starting maps for the watershed management plan (WMP) development process.  
The main difference between the Basemaps and the Map List options is, while any of the Map List options can have a new Basemap added to it, the user cannot add a new Map List option to an existing Map List Content Window.  A popup window will prompt the user to save the changes to the default or to can cancel and choose the World button in the upper left corner to Save As a new unique map for reuse.  This is usually preferred, however if you save the default with your changes, you can resave using Save As and create a name for it, then return the default to its original layout and save the default again.  Once you Save As and start another map or close the program, you can reopen the previously saved map by selecting the World button and choosing the name in the right side of the box with the NMF extension.  These are your map files that had been saved at the point where you left off.
After your default or new map is ready for customizing, right click on the name of a layer in the Contents Window and select Properties.  The Layers Properties box will open to the Descriptions Window.  To see the list of datasets associated with this, click on the last item listed called Sub-Layers.  The Window brings up a directory tree-type list.  As with other Windows products, the small boxes with the plus and minus are like toggles to see subdirectories.  To explore the sub-layers, use the toggles to see the names and symbols for the various datasets that can be visible on the map.  The bold boxes with checkmarks or blank toggle the visibility of each one on the map.  Test them out by setting various to on and click Apply.  After you have the arrangement/selection of features necessary for your map, click on OK to close the Layer Properties window.  Perform this process on each service or operational layer or user provided layer in the Contents Window, as necessary.
4. Setting attributes of layers 
New data layers can be symbolized to provide for the best display by right clicking on the layer name and selecting Symbol.  A dropdown of choices appears which can be scrolled to select from many different point styles and line and polygon colors and symbols.   These tools are not available for the GIS Services layers, however in the coming section of this manual, there is a method for selecting watersheds and saving them as separate Layers for unique symbolization.
(The following includes excerpts taken from AE Resource Center)
5. Adding data and/or other basemap GIS services 
The map you work with in ArcGIS Explorer contains content that's served from one or more servers. You can add content from several other sources to augment what the map conveys or provide the basis for understanding the place you are investigating more fully. This additional content can come from other servers to which you have access or that's available on your local machine or network. The content can take many forms, including layers created in ArcGIS, content that's been exported from another map, globe and map services available from ArcGIS Servers, data from ArcIMS or WMS servers, file geodatabase data, shapefiles, raster data, Keyhole® Markup Language (KML) files, text files that contain addresses or coordinates, and data types in a GPS file. 

You can add content of various types of data to ArcGIS Explorer by using the items under the Add Content button in the Map group on the Home tab. Each of these items presents a dialog box that you can use to specify the files you want to work with. 
In addition to this method of working with files, you can drag files from Windows Explorer onto the map display of a running instance of ArcGIS Explorer and the application will handle the file as if you had selected it in the dialog box. Dragging and dropping files with these extensions onto ArcGIS Explorer are supported at this time:
· ArcGIS Explorer map content files (*.nmc) 

· Keyhole® Markup Language files (*.kml) 

· Compressed Keyhole Markup Language files (*.kmz) 

· Shapefiles (*.shp) 

· Text files (*.txt, *.csv) 

During the course of your ArcGIS Explorer session, whether you are working with an existing map or preparing a new map for others in your organization, you may decide that another basemap better suits the purpose of the map and supports the other contents of the map more meaningfully. In addition you can save your existing map as a basemap and then add it to an application configuration.
To change the basemap

· In the Map group on the Home tab, click Basemap to display the Basemap gallery. 

· Depending on the application configuration you are using, you may see different collections of basemaps:
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· Choose a basemap to replace the current one. 

When you start ArcGIS Explorer for the first time, you'll see that it displays a basemap. The basemap provides context or reference for the content that you add to the map. ESRI supplies several basemaps that you can change without affecting the map's additional content. To change the basemap, click Basemap in the Map group of the Home tab, then select a basemap from the Basemap gallery. While the basemaps that ESRI supplies in the gallery may be appropriate for most of your work, you may find that you require a basemap that's more specifically tailored to your organization's needs. You can create your own basemap and make it available to others. 

To create a basemap

Follow this walkthrough to familiarize yourself with the basic actions required to create a basemap. 
1) Click the ArcGIS Explorer Button [image: image2.png]


. 

2) Click New. 
Indicate whether you want to save any changes you've made to the current map. 

3) Click Basemap in the Map group of the Home tab. 

4) At the bottom of the gallery, click Clear Basemap. 

5) In the Map group of the Home tab click Add Content. 

6) Select the data type to add. In this example, we'll be choosing a Map Content File (.nmc) that references a layer package. Take care in your choice of content; for example, a globe service cannot be displayed in 2D Display mode. Here we select the Map Content File:
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The layer appears in the map display and in the Contents window:
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7) On the Display tab choose any settings you want to display the basemap. 

8) Click the ArcGIS Explorer Button. 

9) Click Save As > New Basemap. 

10) Specify the basemaps options in the Save As Basemap dialog. Here we've changed the default name to reflect what the basemap represents:
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11) Click Save.
The next time you open the Basemap gallery, you'll see the basemap you created in the My Basemaps group:
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To delete a basemap

Select a basemap or multiple basemaps (click + hold Shift or Alt key) then click the Delete button. This will permanently delete the selected basemaps from disk. 
To rename a basemap

Select a basemap, then single click again on the name to make the text editable. Enter a new name then hit the Enter key or click anywhere outside the text area to commit the changes.
6. Accessing the layers data
When you use Add Content in the Home tab's Map group to add content to the map, two of the data types you add will appear in the Ribbon as feature layers: shapefiles and geodatabase data:
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The following table summarizes the actions you can perform on a shapefile or data from a geodatabase; the controls are present on the Tools tab and/or on the context menu that appears when you right-click a feature layer.
	Click
	To do this

	Go To
	Navigate to the extent of the shapefile.

	Show Legend
	Display the Legend window set to display the legend for the feature layer.

	Export
	Export the feature layer to a Map Content file (.nmc)

	E-Mail
	Send a copy of the feature layer as an attachment to an e-mail message. The feature layer is stored as a Map Content file (.nmc)

	Remove
	Remove the feature layer from the map. Note that you can't undo this operation.

	Rename
	Select the feature layer's name for editing. This simply changes the text in the Contents window, not the name of the source data.

	Move to Folder
	Move the feature layer to a folder.

	Symbol
	Change the feature layer's symbol.

	Properties
	Display the Layer Properties dialog, in which you can set the layer's description and attribution, view a summary of its source data, set its refresh options, and control its popup content.

	Set Default View
	Set the view associated with the layer.

	Bring to Front/Send to Back
	Change the drawing order of the layer in relation to other items in the Contents window; note that you won't see anything change in the Contents window, but you will see the changed drawing order in the Manage Layers dialog

	Transparency and Swipe
	Use these controls to change the layer's appearance and reveal what is beneath it. 


To identify the attributes associated with a feature in the layer you've added

Move the mouse over the feature and click it. If a single feature is identified, a popup window will appear displaying the attributes. If multiple features are identified or if features in more than one layer are returned, then the multiple hits window will appear. You can then select a feature from the list to display the attributes. Subsequently if you wish to re-open the multiple hits window, click the [image: image8.png]


 icon. 
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In addition, you can control which fields of the layer display when you click a feature on the map by working with the layer's Popup Content settings in the Layer Properties dialog.

7. Using on-screen and display tools 

You can control the drawing order and presence of layers in the map by using the Manage Layers dialog box. The dialog box shows a list of those layers and group layers that are visible in the ArcGIS Explorer map as well as layers that provide height information to other layers. The former set of layers is referred to as Draped layers; these layers are placed on top of the latter set of layers, the map's Elevation layers, obtaining their z-values (height values) from them.

Here is an example of the dialog box showing several layers:
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To move the display position of a layer:  Select the layer in the treeview and click either the Move Up or Move Down buttons to move the layer in the corresponding direction or you can also drag and drop the layer to the position you want. 
To move layers or layer packages that are group layers or contain group layers: You can move layers or layer packages that are group layers or that contain group layers like any other layers; however you cannot change the order of the layers within the group layer. Note that group layers are not supported directly in ArcGIS Explorer; however layers and layer packages that contain them are. 

To remove a layer from the current map, select the layer and click the Remove button at the right of the dialog box. 
To remove a layer's cache, select the layer and click the Clear Cache button at the right of the dialog box. This has the effect of fetching the most recent data of the service related to the layer.

You can apply effects to the map to control the appearance of layers. Select the layer in the Contents window and you'll see that the Tools tab has the following functionality available in its Effects group to change the appearance of layers:
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	Transparency 
	Transparency can be used for any symbolization type, but it is especially useful for drawing raster layers with other layers on your map. This allows you to see the raster layer while still viewing underlying layers.
To adjust the transparency of a layer:
1. In the Contents window, select the layer whose transparency you want to adjust.
2. Click the Transparency button on the Tools tab.
A slider bar appears which you can move to adjust the transparency of the layer and, depending on how you've set the Layers options, layers above it.
3. Move the slider bar to adjust the transparency; as you move the slider handle upward, the layer becomes more transparent.
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	Swipe
	Use Swipe to reveal layers beneath the layer you chose to swipe and, depending on how you've set the Layers options, the layers above it. This button makes it easy to quickly see what is underneath a particular layer without having to turn it off in the Contents window or reorder layers.
To reveal layers beneath the layer you've selected

Choose the layer or group layer you want to swipe from the Contents window, and then move the cursor over the map. You'll notice that the cursor changes based on whether you are resting the mouse pointer on the top, bottom, left, or right of the map. This lets you choose the direction in which you want to swipe the layer. Hold down the left mouse button and drag in the direction indicated by the mouse pointer. 
Tips

-  With Swipe selected, holding down the Shift key and clicking the mouse will flicker the selected layer on and off manually. The selected layer is off as long as you hold down the mouse. Flicker is particularly useful for temporal change detection (especially of satellite images or air photographs taken at different times of the same location), data quality comparison, and other analysis where you want to see the difference between layers. Fast rates of flicker can be used to make differences between layers appear to jump out due to the optical effect of the eye being attracted to changes between rapidly alternating displays (an effect also exploited by the early experiments in cinematography). 

-  If you hold down the Ctrl key while swiping, you'll remain in Swipe mode. This is useful if you want to continue swiping, but in a different direction, for example up/down after swiping left/right. 

-  Holding down both Ctrl and Shift at the same time will allow you to flicker the display continuously. 


When you add content to ArcGIS Explorer, the way it’s displayed on the map is often defined by the source of the content. For example the control that creates a note will assign a symbol to that note, KML layers define how their features are drawn, and ArcGIS layers' symbology have been defined by their authors. 
In some cases, you’ll decide how the GIS information that you add to the map should be displayed, whether it’s to assign a symbol to a place that you find, or to specify how the features in a shapefile should be drawn.
When you add content to the map (i.e. create a note, add a shapefile, etc), the application assigns a default symbol for you to display the data. You can change the symbol used by clicking the item’s Appearance tab.
The Appearance tab includes a Symbol group that contains various controls for selecting symbols to draw the GIS data with and controls for modifying properties of the symbol. Notice the different galleries for points, line, and areas (polygons):
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The Symbol Gallery

The Symbol Gallery displays the list of symbols available for the type of GIS feature that you are symbolizing (i.e. point, line or polygon). You can scroll through the symbols or drop the gallery down to see more symbols. When you click a symbol, that symbol is assigned and the map updates to display it.
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When displaying point symbols, you can click the Browse… or Add from a Url... button to specify a local file name or Url to use as the source of the point symbol. Symbols specified in this way will be added to a group named My Symbols and remain a part of your Symbol Gallery. You can also add or remove custom symbols using the Manage My Symbols dialog, which can be accessed by clicking on Manage My Symbols.... 

Changing the symbol properties

Once you choose a symbol, you use the other controls in the symbol to change some characteristics of how it’s displayed. Note that the controls are specific to the geometry of the symbol; in other words, some controls only display when you've selected points or lines or polygons. 
Transparency: clicking the transparency control displays a slider control that allows you to change how transparent the symbol displaying the data is. The more transparent, the more you can see the map content that is drawn under the symbolized data. The transparency control is available for all geometry types in feature layers: point, lines, and polygons:
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Point Style: the point style menu gives you the option of displaying the point symbol as a billboarded 3D symbol when the map is in 3D displaymode, or as a rasterized symbol draped on the surface of the map:
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Size: when you add points to a map, a symbol size is assigned for you based on the scale ranges the data is displayed in, what the data represents (that is, a map note versus a GIS feature), etc. In ArcGIS Explorer this point size is represented in terms of pixels or a point to map unit conversion. In most cases, you just want to adjust the symbol to be a little larger or smaller. Two controls, one to increase, the other to decrease the point size, are available in the Appearance tab's Symbol group:
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A similar pair of controls is available for changing the width of lines or the outlines of fill symbols:
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Line Color: you can change the color of a line symbol or the outline of a polygon symbol by clicking the Line Color control to display a selection of standard palette of colors and variations on those colors that you can pick from.
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You can choose to have no color for the line or outline by clicking No Color.

Fill Color: you can change the color of a fill symbol by clicking the Fill Color control. This will display the same color selection control as described above for Line Color.

One of the basic things you can do when working with a map is to ask the simple question, "What's that?". To do this with a ArcGIS Explorer map that contains feature layers or features in a map service, click on a feature to display information about it, in the same way you do when you click on a result. The information presented in a feature's popup window is generally based on the tabular information associated with the feature. You can control which field values appear in the popups by choosing them in the Popup Content panel of the Layer Properties dialog as described below. 
Here's what you can do with popups associated with feature layers or features in a map service:
· Display information associated with a feature 

· Disable popup functionality for a layer 

· Display specific fields in the popup window 

· Display the target of a hyperlink field value 

· Select a field to use for the popup title 

To display information associated with a feature

Click the feature. If a feature is a multi-part feature (lines or polygons) you can click any part to display the value.

To disable popup functionality for a layer

In the Popup Content panel of the Layer Properties dialog choose the Don't display a popup window option:
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To display specific fields in the popup window

In the Popup Content panel choose Display the field values checked in this list option. When you click the feature the popup lists the checked field values associated with the popup:
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Notes:
· If one of the fields you choose to display contains a hyperlink you can click it and the link will open in a separate window. 

· The field values in the dialog box are based on the first feature in the tabular information for the feature layer.

To display the target of a hyperlink field value, for example, an URL, in the popup window

In the Popup Content panel choose Use the value of a field as popup content. When you click the feature the popup displays the Web site page or whatever the hyperlink points to:
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To select a field to use for the popup title

In the Title and Parameter Field section of the Popup Content panel of the Layer Properties choose the field that will display at the top of the popup's window. By checking Display as Tip you can display this text as a tip as you hover over the feature with the mouse. 

8. Set up and show legend

If you want to see the legend information for a layer, you can select the layer in the Contents window and click the Show Legend button on the layer’s Tools tab or in its context menu. Show Legend opens the Legend window with the layer selected and its legend displayed in the window:

[image: image25.png][ U ceoonr
+ Roatpes
[Eppr—"
] st snaEai o roup-

W G

] onorin evpeosmans
p———"
e s






If the Legend window was already open, it becomes the active window and its combo box switches to the layer that was selected when the Show Legend button was clicked. 
Each sub-layer for the layer is displayed expanded by default with its various symbols beneath. The symbols and their labels are basically a picture and non-interactive. The only elements in the legend that are interactive are the arrows next to the sub-layer’s name. You can click the arrow to collapse that sub-layer’s legend information. If you hold down the Ctrl key when you click the arrow, it has the effect of expanding or contracting all of the sub-layers.
The combo box at the top of the window displays the list of layers in the map alphabetically. You can switch the layer and it displays that layer’s legend in the window:
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The following are examples of legends for the different types of layers that you see in ArcGIS Explorer: 
· Feature layers: these are simple single symbol legends and this is reflected in the legend that you see. The following are two examples:
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· Raster Layers: Raster layers will have legends that depict RGB, color ranges, grayscale, etc. The following is an example of a legend for a raster layer:
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· ArcGIS Layers and Layer Packages: these items represent ArcMap documents that have been published as either dynamic or cached map services. In either case, their contents are composed of sub-layers that essentially mirror the map document’s contents in ArcMap. As such, these sub-layers might have single symbols, unique value renderers, be organized into group layers, etc. Note that when you add a map server layer to ArcGIS Explorer you can choose which layers are visible by changing the Layer Properties dialog's Sub-layers sheet. The legend for a map server layer will only display those layers that have been checked as visible. 
The following are examples of the type of legends you might see from a map server (these are simple examples with no group layers): 
· ArcGIS Globe Service Layers: a globe service layer doesn’t contain any sublayers and its legend reflects the legend of the layer that was published as part of publishing a globe document. So, it can be a single symbol, unique value renderer, raster renderer, etc. The following is an example of a globe service layer:
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· IMS Layers: IMS layers are similar to map server layers in that they have a number of sublayers that can be single or multiple symbols, raster, etc. Also similar to map server layers, when you add an IMS service to ArcGIS Explorer, you can choose which layers to be visible (this can be changed in the property page later also). Only those layers that are visible will be displayed in the Legend window. The following is an example of the legend for an IMS service from the Geography Network:
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· WMS Layers: WMS layers are unique in that unlike the other layer types described above, the legend information for a sublayer is drawn by the server and returned to the client (ArcGIS Explorer in this case) as an image. So for WMS layers, under each sublayer, the image returned from the server is displayed. Also, WMS layers can contain a very large number of sublayers that can be nested several hierarchies deep.

When you add a WMS service to ArcGIS Explorer, you can choose which sublayers to include. The set of included sublayers is modifiable in the layer’s Properties page on the Sub-layers sheet. The legend only displays the sub-layers that you set to be visible. 

KML and KMZ files

KML has a number of sub elements (i.e. KML Nodes) arranged in an arbitrary hierarchy. You'll find that KML and KMZ files you add to the map will display in the Contents window. These are not included in the legend because these nodes have more functionality associated with them than do the items of legend information for a layer. For example, you can navigate to a node, display its popup window, use it as input to a result, etc. 
The KML node hierarchy for KML will be displayed in-line in the Contents window with each node establishing context when it’s selected. Additionally, sub-nodes can be turned on or off, etc, etc. The design for displaying and interacting with KML contents will be detailed in another design document.
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9. Saving and printing maps 

You can save and print your map directly from ArcGIS Explorer. You can print the currently visible extent, the north arrow, all copyright and attribution information, and a title. ArcGIS Explorer supplies the font for the text and the layout for the printed map; however you can designate the printer to which to direct output, the paper size, and whether to print in landscape or portrait mode. The graphic displayed in the dialog box serves to illustrate the orientation of the map.
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To display the Print dialog

Click the ArcGIS Explorer Button [image: image34.png]


and then click Print.
Keyboard shortcut To display the Print dialog box, press Ctrl + P. 

If you need to add other map surrounds and information to the printed output you may be better served by copying the current view to the Clipboard and pasting it into an application whose documents accept bitmaps and use its printing capabilities.

Note:  ArcGIS Explorer disables the Print button if data to be included on the printed map is not completely drawn (that is, streaming is still in progress); as soon as all visible data finishes drawing, you'll be able to print:
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Note that the title you specify is not shown on the preview, but will be printed centered, above the map. Consider using an Image Overlay if the automatic placement and font of the title does not meet your needs.
(End of Excerpts.)

10. Using the Maps List to create the watershed management plan maps

The Map List tab offers 6 different basemaps to start you on the way to making your initial WMP maps.  They are 1-Project Area, 2-Soils, 3-LandUse, 4-Existing Activities, 5-Data Sources, and 6-Critical Areas.  (The final one 7-LndUse test is provided as an additional template for customization of additional data should it be needed.)  The 1-Project Area should be used to help you locate and designate your WMP extent and be included in your plan as your first map of the area of concern.  The second through fifth maps are to be used for presenting the data in the inventory section of the WMP.  Each one can be used with additional data you may want to provide based upon your needs.  The sixth preset map is for delineating critical areas.  
Later in the instructions, you will be provided with the means to create more of these maps as needed to address all of your planning issues and needs.  In the following sections, each map will be described with direction on what is expected to help communicate the details of the plan.  However, during your development of these maps, be sure to follow the WMP Checklist directions to ensure all inventory and results data that is available for mapping are used.
11. Using the IWQA Tools Project Area Map

From the Default Map screen, select from the Map List dropdown the 1-Project Area Map that will provide the basemap layers for your first map in your watershed management plan.  The HUC 8 and County boundaries are available along with major roads to help orient you.  Next select the IWQA Tools tab and click on the Watershed Navigator.  
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The popup window requests that you provide either the name or code of the HUC you wish displayed.  Once you have selected the radio button you need, select the type (size) of HUC, then select the name/code from the dropdown list below it.  Next click on the Zoom to Watershed button (text) and the application will zoom to the selected extent.  At this point there is no distinction between it and adjacent HUCs.  

To create a unique boundary for this watershed, click on the Add Watershed to Map button and a layer of only this boundary will be added to the Contents.  The default color is yellow, but this can be changed to suit your map design.  If your project area incorporates more than one HUC 12 or HUC 10, select each one (of the appropriate type) and Add Watershed to Map.  You will have 2 or more polygons listed in your Contents when finished.

To change the highlight of yellow to another color that may show or print better, right click on the layer name in the Contents and slide down to Symbols.  A side menu will provide alternatives for line and/or fill color changes.  For boundaries only, slide down to the colored outlines and select a color.  (The left side slide will provide other colors for this option.)  To make this Layer available again without having to re-search and change attributes, right click on the name and select Export.  It will default the name into the default user file that can be retrieved for subsequent maps.
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The above map shows the initial selection and layer that was created from the Add Watershed to Map button. 
Other changes can be made from adding new layers to editing layers within the SimpBaseMap Service.  To perform the latter, right click on the IWQA/IWQA_SimpBaseMap and click on Properties.  In the Properties box select Sub-Layers and switch on and off the annotation and other layers (as you scroll down) until you have showing the desired map data combination with labels (based upon the annotation layers you activate.)  Select Apply to see your changes and Save to complete the edits to the Sub-Layers Properties.

Continue to add, edit, and annotate your layers; however you do not have to finish this map to begin the next one.  When ready to stop, go to the top left World button dropdown and save the List Map with your current work under Save As ArcGIS Explorer with a new name.  This will keep your original List Maps clean for the next version of any of these that you may want to add to your WMP.  These NMF files will be available to reopen at anytime by selecting the World button again and the list of previously saved maps will be on the right side of the box.

12. Soils Map

With the previous map saved, click on the Home tab and select the 2-Soils Map from the Map Lists dropdown.  To add the previously defined Layer that represented the Watershed, you will find it in the default folder on your PC or laptop (C:\Documents and Settings\<user login>\My Documents\ArcGIS Explorer\).  The tool to add it to the next map is Add Content, Map Content Files.  It will open this default folder of NMC files – exports of Layers that you save.
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With the Soils map, setup the Layers in the Simple Basemap service and Operational Layers attributes to represent what you wish to communicate.  There are 2 ways to access the tabular data:  
1) The cursor hand as an identify tool.  Click anywhere you want to review information about that point.  A popup will provide data specific to the named layer at the top of the popup box.  This information can be recorded or cut and pasted into your document.
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2) Under the IWQA Tools, there is an Identify button that will provide a popup of the data offered through the GIS Services as well as the other layers that may have data at this point.  To the left is an example of the results, however, only one layer of the data was found in this case -  the NHD Rivers and Streams recorded Verdrick Ditch, an intermittent stream off of Brown Ditch off of the West Branch of Clear Creek.  (This ditch is primarily in the Blount-Glynwood-Morley soils unit, noted previously.)
Next if desired, add point data to the soils map that may be affected by the soils characteristics, especially highly erodible soils.  Also add local layers of soils data that were collected by the county, region, or other local effort to increase your understanding and representation of conditions relating water quality issues.  Confined feeding operations, construction sites, as well as conventional tillage practice areas are some of the options for reviewing the potential impact on highly erodible land.
Again, Save As any work in progress or finished layout before switching to another existing or new mapping project.

13. Land Use Map


Due to the fine level of detail that can be found in local and county landuse data, you may want to use multiple subwatershed level maps to delineate a larger 10-digit or multiple 10-digit watershed areas, especially in areas where significant change has been occurring.  The landuse /land cover layer provided is from 1983 so adding more recent data in developing areas would be necessary and other services on the web are available to be added to this application or are downloadable for access from your computer.
Some of the point datasets that would work well with this layer include permitted facilities, sampling/monitoring sites, and locations of windshield surveys.   

14. Creating graphics for additional communication capabilities 
Adding graphic details for locations of activities not available in a geospatial layer is possible by using the tools under the Create Notes box of the Home Tab.  The 4 drawing tools allow you to mark on the map the locations and configurations of existing activities and other special notations relevant to the inventory of the watershed project.  These do not need to have extensive notes, however entering enough information to recall on the map its significance is important.  Also, don’t forget to discuss this notation in the text of the WMP.  

To use the tools, simply click on the point line or area tool to start the process.  The cursor will change to cross hairs.  Click on the point or first point of your line or area.  Click again for additional nodes that define the changes in direction and double click on the final node to end the drawing session with that tool.  The area tool automatically closes once you click on the last interim node so you do not need to click on the first point placed to close the polygon area.
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The target tool provides a pushpin to register a note in a general area at the center of the screen so be sure to have the area needing a note is in the center of the screen.  The point tool provides the ability to place the point exactly where you click.
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15. Existing Activities Map

This map should include such items as what is happening in the watershed not already being included in other parts of the WMP inventory and other data needed for the planning process but are not currently in a publicly available or user provided layer.  These could be higher resolution details about available lower resolution features, unique projects or other important projects that would impact the development and/or implementation of the WMP, such as major road construction or property development.  Also, these tools can be used to call out data gaps as noted in the previous figure. 
16. Creating additional WMP Maps within the Maps List

In the case where more maps may be needed and/or preferred, there is a way to add to the Map List choices.  This will be especially handy if doing more than one WMP or doing many subwatersheds in a large or multiple watersheds area.  This can be done by:
Select an existing Map List and set it up with new and/or unique layers that are relevant to the plan or project.  Once set with the desired attributes and details, click on the World button and move your arrow over Save As but do not click.  There are 3 choices for saving that appear to the right: ArGIS Explorer Map, My Default Map, and New Basemap.  The first one will provide a new map under Map List, however the application will need to be closed and reopened to have it show up in the list.  Until then it will only be in the list of recent maps offered in the World button dropdown.  The second one will take you back to a blank default if you accidentally saved a project to default, and the third allows for adding new basemaps to the list of Basemap options.  This third option gives the flexibility to add a local or other base data layer to every or any map project without setting up a map in advance and adding it to the Map List.  The following image shows the choices for saving.
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In this image the confined feeding operations are shown with the impaired water bodies in and around the watershed in question.  The layers set for this map can be used over again in other areas of the state without having to go through the process of setting layers on or off, setting attributes or annotation for initial use for a new project area map.

17. Data Sources Map(s)

This map provides the initial essentials for collecting existing water quality and other related data as well as new, local or other source data needed for the planning process.  Offered under the IWQA/Operational Layers are such point data sets as the IDEM Assessment Information Management System (AIMS) water quality data, the locations of confined feeding operations, leaking underground storage tanks (LUST), permitted facilities and outfalls, USGS Gaging Stations, and other linear and polygon data such as the 2008 303d List of Impaired Waters and the distribution of wetlands per the latest draft of the National Wetlands Inventory (NWI) for Indiana.  Other layers of interest may be found under additional GIS Services available through IDEM (2 are already listed as options for data sources under GIS Services) and the other public GIS web services by using the New Server Connection button.  If you have the URL for a public server, add it to the wizard and complete the Add GIS Service request.
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18. Additional data analyses using the Maps and Tools
This is a good place to start working with the spatial analysis and other tools provided to evaluate the available data.  Under the IWQA tab there are the tools already explained - i.e., the Watershed Navigator, Add a Legend, and Identify Service, and the tools for analyzing data – the Graph AIMS Data tool and the L-THIA Model tools.  Also the Extract tool for downloading the AIMS data appears here.

To use the Graph AIMS Data tool, click on it and from the popup window select the watershed in question.  All points that fall within this area will be listed.  Click in the first site number listed and a new window will popup and it will include a graph of the first parameter that was tested at this location.  A dropdown of other parameters should be reviewed to see the graphs from each sample taken over time for this location.  To transfer these graphs to a report, using Alt + Print Screen will copy the image for pasting into a document or other file format.  Capturing each graph for each parameter for each site may be too much and this will be a good time to consider downloading the data for analysis in another GIS or statistical software.  For limited datasets or a quick review, this tool should provide the data and results needed.
The Watershed Delineator and L-THIA Model are available as well for delineating a different area other than the prescribed HUC levels and performing land use/land cover analysis per the predetermined area..  The data sources for running these models include rasterized digital elevation model layers for the delineations and land use/land cover data for the L-THIA analysis.
These tools are also available and fully explained by going to the Purdue University website at https://engineering.purdue.edu/~lthia/; however, the applications are easily run using the default settings.  Customizing the data using your own sources can add to the accuracy of your results.
19. Critical Areas Map

This map provides the basemap layers again and a place to digitize your critical areas using the Notes tools under the Home tab.  This was touched on in an earlier section.  Other options are bringing in a shapefile of points or other feature types to represent these areas or using GPS data if collected from windshield surveys or other activities while collecting inventory data.  Also, if there are any locations prearranged for BMP installations, this would be a good map to include them.  These should be GPS points or polygons however heads up digitizing using the Notes tools will be sufficient for planning purposes.
Be sure to include the notes expressing what each area or point represents before finalizing the map.  These references will be helpful for the writer, editor, and readers of the plan.

20. Examples of Maps Created in This Application

Below are examples of maps that would be acceptable for WMP requirements, however these are just suggestions and individual maps will vary depending on the size of the area, amount and extend of data, and other key issues needing to be evaluated, as well as the number and types of critical areas.
(As this application version is further evaluated, examples will be added periodically to this document.)
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